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Overview

For many microcontrollers, adding audio input is easy with one of our analog microphone

breakouts (http://adafru.it/1063). But as you get to bigger and better microcontrollers and microcomputers, you'll find
that you don't always have an analog input, or maybe you want to avoid the noise that can seep in with an analog mic
system. Once you get past 8-bit micros, you will often find an 12S peripheral, that can take digital audio datain! That's
where this 12S Microphone Breakout comes in.

Instead of an analog output, there are three digital pins: Clock, Data and Word-Select. When connected to your
microcontroller/computer, the 'I12S Master' will drive the clock and word-select pins at a high frequency and read out
the data from the microphone. No analog conversion required!
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The microphone is a single mono element. You can select whether you want it to be on the Left or Right channel by
connecting the Select pin to power or ground. If you have two microphones, you can set them up to be stereo by
sharing the Clock, WS and Data lines but having one with Select to ground, and one with Select to high voltage.

sPH6'+'5'
-

This 12S MEMS microphone is bottom ported, so make sure you have the hole in the bottom facing out towards the
sounds you want to read. It's a 1.6-3.3V device only, so not for use with 5V logic (its really unlikely you'd have a 5V-
logic device with I12S anyways). Many beginner microcontroller boards don't have 12S, so make sure its a supported

interface before you try to wire it up! This microphone is best used with Cortex M-series chips like the Arduino Zero,
Feather MO, or single-board computers like the Raspberry Pi.
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Assembly

Assembly is really easy, you can use straight or 'right-angle' style headers to attach to the PCB. We'll be using the plain
straight headers included

The board comes with all surface-mount components pre-soldered. The included header strip can be soldered on for

convenient use on a breadboard or with 0.1" connectors. You can also skip this step and solder on wires.

Prepare the header strip:
Cut the strip to length if necessary. It will be easier to

il O g OO e PO o B ¥ o solder if you insert it into a breadboard - long pins down
- e - e e B R R
P R rrr T T
B m om @ 4w AW @ @ E @R WA A E R e R R e
W W @ W W s E W e e W E RS AR RN
G oW W @ W W W W RO RN S W W W EWE NN R NN NN
W oa ow @ E W R E W W W R R R R
ol B B B B B B B @ W @ R E N R .
DI.II.llnnlwiiiiiiititliiiﬂ
T @ W W W W W W W W a NSNS EE NSNS RN
= @ @ W @ W s 8§ 8§ F 8 EE NN NN NN NN -
= @ W W @ W W W EE N E W N WS N W ENEE NN N

Add the breakout board:

Place the breakout board over the pins so that the short
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Make sure the side with the components is face down, as shown in the photos in this guide!
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And Solder!

Be sure to solder all 5 pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to
Excellent Soldering (https://adafru.it/aTk)).
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Pinouts

Unlike most of our breakouts, this sensor has the detection element on the bottom of the PCB, so we expect you to
solder it 'upside down' with the sensor package on the bottom and the port on top!

Power Pins

e 3V -this is the power in pin. Technically it can be powered from as low as 1.6V to 3.6V but you'll need to make
sure your logic level matches!
® GND - power and data ground

[2S Data Pins

® BCLK - the bit clock, also known as the data clock or just 'clock' - comes from the 12S master to tell the
microphone its time to transmit data. This should run at 2-4 MHz but we've found you can often run it a little
slower and it'll work fine

e DOUT - the data output from the mic!

e LRCLK - the left/right clock, also known as WS (word select), this tells the mic when to start transmitting. When
the LRCLK is low, the left channel will transmit. When LRCLK is high, the right channel will transmit.

e SEL - the channel select pin. By default this pin is low, so that it will transmit on the left channel mono. If you
connect this to high logic voltage, the microphone will instantly start transmitting on the right channel.

© Adafruit Industries https://learn.adafruit.com/adafruit-i2s-mems-microphone-breakout Page 9 of 30



Arduino Wiring & Test

Remember, the 12S microphone requires an I12S peripheral and won't work with chips that don't support it in hardware!
For this example we'll use a Feather MO, but you can also use an Arduino Zero.

Wiring
For Feather MO, Ardruino Zero and friends, use the following wiring:

GND connected GND

3.3V connected 3.3V (Feather, Zero) or VCC (MKR1000, MKRZero)

LRCLK / WS connected to pin O (Feather, Zero) or pin 3 (MKR1000, MKRZero)
BCLK connected to pin 1 (Feather, Zero) or pin 2 (MKR1000, MKRZero)

Data /SD connected to pin 9 (Zero) or pin A6 (MKR1000, MKRZero

You can leave Select disconnected
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https://adafru.it/uya
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I2S Library

Luckily, there's a nice little 12S library already written for Arduinos based on the SAMD processor. Make sure you have
the most recent Arduino IDE and SAMD core. Then select the board you're using (e.g. Adafruit Feather MO) and you'll
see the I12S library examples show up in the pulldown menu
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L
InputSerialPlotter | Arduino 1.8.

Edit Sketch Tools Help
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Open... Ctrl+0
Open Recent

Sketchbook

Examples

Close Ctrl+W

Save Chrl+S

Save As... Ctrl+Shift+5
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Print Ctrl+P

Preferences  Ctrl+ Comma

You could try the InputPlotter demo but this code is higher resolution:
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/*

This example reads audio data from an I2S microphone

breakout board, and prints out the samples to the Serial console. The
Serial Plotter built into the Arduino IDE can be used to plot the audio
data (Tools -> Serial Plotter)

Circuit:
* Arduino/Genuino Zero, MKRZero or MKR1000 board

* GND connected GND
3.3V connected 3.3V (Zero) or VCC (MKR1000, MKRZero)
WS connected to pin 0 (Zero) or pin 3 (MKR1000, MKRZero)
CLK connected to pin 1 (Zero) or pin 2 (MKR1000, MKRZero)
SD connected to pin 9 (Zero) or pin A6 (MKR1000, MKRZero)

created 17 November 2016
by Sandeep Mistry
*/

#include <I2S.h>

void setup() {
// Open serial communications and wait for port to open:
// A baud rate of 115200 is used instead of 9600 for a faster data rate
// on non-native USB ports
Serial.begin(115200);
while (!Serial) {
; // wait for serial port to connect. Needed for native USB port only

}

// start I2S at 16 kHz with 32-bits per sample

if (!I2S.begin(I2S PHILIPS MODE, 16000, 32)) {
Serial.println("Failed to initialize I2S!");
while (1); // do nothing

}

void loop() {
// read a sample
int sample = I2S.read();

if ((sample == 0) || (sample == -1) ) {
return;

}

// convert to 18 bit signed

sample >>= 14;

// if it's non-zero print value to serial
Serial.println(sample);

Upload to your Arduino Zero/Feather wired up as above, and open up the Serial Plotter
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VU Meter Demo

Often times you don't want the actual audio data but the overall "sound pressure level". This example will take a bunch
of samples, normalize the data to be around 0, then give you the maximum difference between the waveforms for a
'volume graph'

/*

This example reads audio data from an Invensense's ICS43432 I2S microphone
breakout board, and prints out the samples to the Serial console. The
Serial Plotter built into the Arduino IDE can be used to plot the audio
data (Tools -> Serial Plotter)

Circuit:
* Arduino/Genuino Zero, MKRZero or MKR1000 board
* 1CS43432:
* GND connected GND
3.3V connected 3.3V (Zero) or VCC (MKR1000, MKRZero)
WS connected to pin 0 (Zero) or pin 3 (MKR1000, MKRZero)
CLK connected to pin 1 (Zero) or pin 2 (MKR1000, MKRZero)
SD connected to pin 9 (Zero) or pin A6 (MKR1000, MKRZero)

created 17 November 2016
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by Sandeep Mistry
*/

#include <I2S.h>

void setup() {
// Open serial communications and wait for port to open:
// A baud rate of 115200 is used instead of 9600 for a faster data rate
// on non-native USB ports
Serial.begin(115200);
while (!Serial) {
; // wait for serial port to connect. Needed for native USB port only

}

// start I2S at 16 kHz with 32-bits per sample

if (!I2S.begin(I2S PHILIPS MODE, 16000, 32)) {
Serial.println("Failed to initialize I2S!");
while (1); // do nothing

}

#define SAMPLES 128 // make it a power of two for best DMA performance

void loop() {
// read a bunch of samples:
int samples[SAMPLES];

for (int i=0; i<SAMPLES; i++) {
int sample = 0;
while ((sample == 0) || (sample == -1) ) {
sample = I2S.read();
}
// convert to 18 bit signed
sample >>= 14;
samples[i] = sample;

// ok we hvae the samples, get the mean (avg)
float meanval = 0;
for (int i=0; i<SAMPLES; i++) {

meanval += samples[il];

}
meanval /= SAMPLES;
//Serial.print("# average: " ); Serial.println(meanval);

// subtract it from all sapmles to get a 'normalized' output
for (int i=0; i<SAMPLES; i++) {

samples[i] -= meanval;

//Serial.println(samples[i]);
}

// find the 'peak to peak' max

float maxsample, minsample;

minsample = 100000;

maxsample = -100000;

for (int i=0; i<SAMPLES; i++) {
minsample = min(minsample, samples[i]);
maxsample = max(maxsample, samples[i]);

}

PPN, B i, (R U, NIRRT, B
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Open up the serial plotter to see how making noises will create peaks!
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ArduinoSound Library

For most uses, its better to have a higher-level library for managing sound. The ArduinoSound library works with 12S
mics and can do filtering, amplitude detection, etc!

Install it using the Arduino library manager

Library Manager ﬂ
Type all = Topic all » | |arduinosound
ArduinoSound by Arduino -
[EXPERIMENTAL] A simple way to play and analyze audio data using Arduino. Currently only supparts SAMD21 boards and 125
audio devices.
More info
Instal

Various examples come with the library, check them out in the File->Examples->ArduinoSound sub menu
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For example, amplitude Serial plotter will do basic amplitude plotting:
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You can also do FFT spectral diagramming

that all 128 bins are plotted:
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SpectrumSerialPlotter | Arduine 1.8.1

Eile Edit Sketch Tools Help

SpectrumSerialPlotter &

l if (!'fftRAnalyzer.input {AudicInI25)) {
Serial.println("Failed to set FFI analyvzer input!™);
while {1); // do nothing

volid loop() {
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if (ffthAnalvzer.available()) {
/{ read the new spectrum
ffthAnalyzer.read(spectrum, spectrumSize);

// print out the spectrum
for (int 1 = 0; 1 < spectrumSize; i++) |
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Raspberry Pi Wiring & Test

You can add mono or stereo 12S microphones to your Raspberry Pi, too!
This will work with Raspberry Pi B+, 2, 3, Zero and any other 2x20-connector-Pi

This guide is largely based on this great git repo https://github.com/nejohnson2/rpi-i2s (https://adafru.it/vka)

Wiring For Mono Mic

Mic 3V - Pi 3.3v

Mic Gnd - Pi Gnd

Mic LRCL - Pi Gnd (this is used for channel selection. Connect to 3.3 or GND)
Mic BCLK - BCM 18 (pin 12)

Mic SEL - BCM 19 (pin 35)

Mic DOUT - BCM 20 (pin 38)

DSI (DISPLAY)

® & & 8 & 8 8 8 8 080

e & & 8 & 8 8 8 080 s a e
S & & 8 & 5 5 5 8 8 8 8 88
a & & 5 5 & & 8 8 8 BB e E e

a & & 8 5 8 8 8 8 00
e & & 5 & & & 8 8 8 8

fritzing

https://adafru.it/vkb

https://adafru.it/vkb

Wiring For Stereo Mic
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fritzing

https://adafru.it/vkc

https://adafru.it/vkc

Raspberry Pii2s Configuration

Start by logging into your Raspberry Pi via a terminal, we recommend ssh so you can copy + paste the many
commands.

Turn on i2s support by editing /boot/config.txt with:

sudo nano /boot/config.txt

Uncomment #dtparam=i2s=on
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@ @ pi@raspberrypi: ~

Next, we'll make sure sound support is enabled in the kernel with:

sudo nano /etc/modules

Add snd-bcm2835 on its own line, to the modules file as shown below

@ @ pi@raspberrypi: ~

Now reboot your pi with:
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sudo reboot

Once rebooted, re-log in.

Enter the following to confirm the modules are loaded

lsmod | grep snd

@ @ pi@raspberrypi: ~

Kernel Compiling

Ok now its time for the fun part! You'll manually compile in i2s support.

Start by updating your Pi:

sudo apt-get update
sudo apt-get install rpi-update
sudo rpi-update

Then reboot!

Install the compilation dependencies:

sudo apt-get install git bc libncurses5-dev

Download kernel source & compile:
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sudo wget https://raw.githubusercontent.com/notro/rpi-source/master/rpi-source -0 /usr/bin/rpi-source
sudo chmod +x /usr/bin/rpi-source

/usr/bin/rpi-source -q --tag-update

rpi-source --skip-gcc

On a Pi 3 this will take many many minutes, so don't worry if its taking 15 minutes. On a Pi Zero it can take an hour or
longer!

@ @ pi@raspberrypi: ~

Prepare to Compile the i2s module

Now you're ready to compile i2s support:
sudo mount -t debugfs debugs /sys/kernel/debug

This may already be done - mount: debugs is already mounted - in which case keep going
If you are using Pi 3 or Pi 2 - make sure the module name is 3f203000.i2s

If you are using Pi Zero - the module name is 20203000.i2s

sudo cat /sys/kernel/debug/asoc/platforms
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@ @ pi@raspberrypi: ~

Download the module, written by Paul Creaser (https://adafru.it/vkd)

git clone https://github.com/PaulCreaser/rpi-i2s-audio
cd rpi-i2s-audio

Pi Zero Only

If you are using a Raspberry Pi Zero, editmy_loader.c with nano my_loader.c and change the two lines
.platform = "3f203000.i2s",

and

.name = "3f203000.i2s",

with

.platform = "20203000.i2s",

and

.name = "20203000.i2s",
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-
@ pi@raspberrypi: ~/rpi-i2s-audic |ﬂ|ﬁj

GNU nmano 2.2.6 File: my loader.c Modified -

If you aren't using a Pi Zero, continue on!

Compile the module with

make -C /lib/modules/$(uname -r )/build M=$(pwd) modules
sudo insmod my loader.ko

Verify that the module was loaded:

lsmod | grep my loader
dmesg | tail

-
@ pi@raspberrypi: ~/rpi-i2s-audio |iﬂ|&]

Note that on the Pi 2/3 you'll see asoc-simple-card asoc-simple-card.0: snd-soc-dummy-dai <-> 3F203000.i2s mapping ok on

the last line and on Pi Zero you'll see asoc-simple-card asoc-simple-card.0: snd-soc-dummy-dai <-> 20203000.i2s mapping ok

Auto-load the module on startup

Now you can set it up so the module is loaded every time you boot the Pi
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sudo cp my loader.ko /lib/modules/$(uname -r)

echo 'my loader' | sudo tee --append /etc/modules > /dev/null
sudo depmod -a

sudo modprobe my loader

And reboot!

sudo reboot

Test & Record!

OK that was a lot of effort but now you are ready to rock!

Use the following command to list the available input devices:

arecord -1

you should see a snd_rpi_simple_card

r@ pi@raspberrypi: ~ | =HAC! &]1

card 1: sndrpisimplecar [snd rpi simp card], device 0: =simple-card codec link

You can record a wav file in mono with this command:

arecord -D plughw:1 -cl -r 48000 -f S32 LE -t wav -V mono -v file.wav

Or, if you have two i2s mics installed, record in stereo with this command:

arecord -D plughw:1 -c2 -r 48000 -f S32 LE -t wav -V stereo -v file stereo.wav

If all is working correctly, you should see the VU meter react at the bottom of the terminal window
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[ BN pi@raspberrypi: ~

Test Playback

If you have speakers hooked up to the Pi, you can play the file back directly on the device:

aplay file.wav

Or, you can copy it over to your computer for playback :), just insert your Pi's IP address below:

scp pi@<local-ip>:/home/pi/file.wav ~/Desktop/file.wav

Adding Volume control

You can add volume control to your mine via alsamixer and alsa config. (Hat tip to RickTracer (https://adafru.it/doW))
Run sudo nano ~/.asoundrc

and put the following in:
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#This section makes a reference to your I2S hardware, adjust the card name
# to what is shown in arecord -1 after card x: before the name in []
#You may have to adjust channel count also but stick with default first
pcm.dmic_hw {

type hw

card sndrpisimplecar

channels 2

format S32_LE

¥

#This is the software volume control, it links to the hardware above and after
saving the .asoundrc file you can type alsamixer, press F6 to select
your I2S mic then F4 to set the recording volume and arrow up and down
to adjust the volume
After adjusting the volume - go for 50 percent at first, you can do
something like
arecord -D dmic sv -c2 -r 48000 -f S32 LE -t wav -V mono -v myfile.wav
pcm.dmic sv {
type softvol
slave.pcm dmic hw
control {
name "Boost Capture Volume
card sndrpisimplecar

H o B H R B

}

min dB -3.0
max_dB 30.0
}

@ pi@raspberrypi: ~ |£|E|éj1

GHNU nmano 2.7.4 File: /home/pi/.asoundrc Modified -

EEE e

=

Now before you can change the volume you need to use the device once (this is an alsa thing)

Run
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arecord -D dmic sv -c2 -r 44100 -f S32 LE -t wav -V mono -v file.wav

And cancel with *C once it starts recording.

Now you can run alsamixer - press F6 and select the 12S simple sound card

(o o [ |

@ pi@raspberrypi: ~
AlsaMixer v1.1.3

bem2835 ALSA

Sound Card
— {default)
0 bcmZ835 ALSA

1 =nd rpi simple card

enter device name...

It will complain there are no playback controls (because its for recording only).

Press F5 to change the volume.

| File Edit Tabs Help
AlsaMixer v1.0.28 -
snd_rpi simple card

; : bac ~4: [Capture]

Boost [dB gain: 36.20, 36.20]

Then you can record with the i2¢c mic device using
arecord -D dmic_sv -c2 -r 48000 -f S32_LE -t wav -V mono -v recording.wav
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and playback with

aplay recording.wav
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Downloads

Files

® EagleCAD PCB Files on GitHub (https://adafru.it/uyb)

e Fritzing object in the Adafruit Fritzing library (https://adafru.it/aP3)

Schematic & Fab Print

Z 3 5 I3
A
~
]
{ |:|
r =1
E
b L
“Oes
155U€ ADAFRUIT INDUSTRIES ‘ © za18
ORALN TITLE REYU
(] .
CHECKED ﬁ
DATE ORG N¢
oATE 2/2a/20817 3:30:54¢ PH >0RGNO
FILE: SPKA41SHM4H rev A [PaGE: 1,1
i Z 3 5 6

© Adafruit Industries Last Updated: 2018-09-12 03:55:52 AM UTC

Page 30 of 30


https://github.com/adafruit/Adafruit-I2S-Microphone-Breakout-PCB
https://github.com/adafruit/Fritzing-Library
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